
The Control Panel

The “Control Panel” is one of the two “permanent” panels of xrec, the other being the “Record Selector”. Its main usage is to set 
on/off display switches that change the appearance and layout of the displayed fields. 

The first row contains pull-down menus, each of which will be explained in the following pages.

The “File” menu

The “File” menu offers the following items :

• About xrec... gives info about the program version
• Open other standard files invokes the file selector to open other standard files
• Close standard files closes one or more currently opened standard files
• Produce picture... opens a dialog box to write the contents of the drawing or cross-

section window into a file in the PNG format
• Produce sequence... creates a temporal sequence of PNG files that can be reused to 

create an AVI or MPEG movie
• Quit quits the program without keeping the current configuration
• Quit and save configuration quits the program and saves part of the current 

configuration into a file located in $HOME/.startrec
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The “Display” menu 

The “Display”  menu offers the following items :

• “Colors” turn on/off the display of colors
• “Contours” turn on/off the display of colors
• “Labels” turn on/off the display of colors
• “Central Values” turn on/off the display of colors
• “Geography” turn on/off the display of colors
• “Source grid” turn on/off the display of colors
• “Output grid” turn on/off the display of colors
• “Legend” turn on/off the display of colors
• “Color Legend” turn on/off the display of colors
• “Smoothing” turn on/off the display of colors
• “Local Extrema” turn on/off the display of colors
• “Topography” turn on/off the display of colors
• “Missing Values” turn on/off the display of colors
• “Redraw Window after selection” turn on/off the display of colors

The “Color” Toggle
“On” status “Off” status

 

The “Contours” Toggle
“On” status “Off” status
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The “Labels” Toggle
“On” status “Off” status

The “Central Values” Toggle
“On” status “Off” status

The “Geography” Toggle
“On” status “Off” status

XREC User Guide – Section 05 - Control Panel  - 2005-04-20 - Page 3 of 16



The “Source Grid” Toggle
When this option is activated every grid point of the source grid is displayed as an hollow circle.
“On” status “Off” status

The “Output Grid” Toggle
When this option is activated every grid point of the output grid (any grid selected from the grid menu which is not “Field #1”) is 
displayed as an black square.

“On” status “Off” status

The following figures show the display when both the “Source grid” and “Output grid” options are activated. The grid point values are 
always shown on the output grid.
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The “Legend” Toggle
“On” status “Off” status, “Colors” deactivated

“Off” status, “Colors” activated. “Off” status, “Colors” deactivated. Note that when the “Legend” and 
“Color Legend” are de-activated the field display fills the whole 
window. 
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The “Color Legend” Toggle
“On” status “Off” status

“Off” status, “Colors” deactivated. Note that when the “Legend” and “Color Legend” are de-activated the field display fills the 
whole window. 

The “Smoothing” Toggle
“On” status. The field is interpolated at every pixel. “Off” status. Each grid point is represented by a square.
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The “Local Extrema” Toggle
This option is used to alter the color scale of the field. When off, the colors are calibrated to the global variations of the field (max – 
min). When on, the colors are calibrated on the local variations of the field within the visible window. This option has for effect to 
increase the color spread. When on, the contents of the color legend give an indication of the range of values within the visible 
window.
“On” status “Off” status

The “Topography” Toggle
This option masks the parts of the displayed field that are below the ground. To work, this option needs a surface pressure field (P0), 
valid at the same date, to be present in the input files. This option works only in pressure coordinates. 
“On” status “Off” status
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The “Missing Values” Toggle
When activated, this option masks the portions of the field that are considered missing. See Section 20, “Handling missing values” for 
details. 
“On” status “Off” status
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The Grid menu :

The “Grid” menu offers the following items :

“Field #1” : the source grid on which the displayed field is defined
... : a list of grids defined :

from  a GRILLE statement in the files 
$ARMNLIB/data/dict_rec.e 
$HOME/.recrc

Each of these grids define an output grid on which the source grid is interpolated

Here are some samples

GRILLE('North Hem./Amer.  - PS 40km',PS,401,401,200.5,200.5,40000.,21.,NORD) GRILLE('Southern Hem.     - PS 40km',PS,401,401,200.5,200.5,40000.,21.0,SUD)

GRILLE('Canada    - PS 20km',PS, 351,261, 121.5, 281.5,20000.0,21.0, NORD) GRILLE('Global Latlon 721x361- 0.5deg',LATLON,721,361,-90.0,180.0,0.5,0.5)
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The Vectors menu :

The “Vectors” menu provides some control about how the program 
handles vector fields (currently only the pair UU-VV is recognized as 
vectors). By default, when either a UU or VV field is selected, the 
program tries to load its companion field (VV or UU respectively) and 
displays the pair as vectors. The “Process as vector, display as vector” is 
set by default.

The “Vectors” menu can also be used to display the selected component 
as a scalar field instead of vector. Moreover, when the output grid is not of the same nature as the source grid, vector interpolation 
needs to be done on the source fields to get accurate results. So if you want to display the wind component as a scalar field but you are 
displaying the field on a different grid, you will want to use the  “Process as vector, display as scalar” option.

If the option “Process as scalar, display as scalar” is activated, then the selected wind component will be interpolated (if needed) and 
displayed as a scalar, like the temperature or geopotential. Use this option with caution, since the interpolation results of the wind 
component on an incompatible grid will be meteorologically wrong.

“Process as scalar, display as scalar” : 

“Process as vector, display as vector” : “Process as vector, display as scalar” : 

“Process as scalar, display as scalar (E source grid, OK)” : “Process as scalar, display as scalar” (PS output grid, WRONG) : 
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The “Calc” menu :

The “Calc.” menu offers the possibility of performing simple arithmetic 
operations on super-imposed fields :

• “No calculation” does not perform any calculations on the 
superimposed fields.

• “Field1 – Field2, Field3 – Field 4” subtracts the superimposed 
fields, by pairs. 

• “Field1 + Field2, Field3 + Field 4” adds the superimposed fields, by 
pairs. 

• “ABS(Field1 – Field2), ABS(Field3 – Field 4)” subtracts the 
superimposed fields and computes the absolute values of the differences, by pairs.

• “ABS(Field1 +Field2), ABS(Field3 + Field 4)” adds the superimposed fields and computes the absolute values of the sums, by 
pairs.

See section 19, “Comparing Fields” , for more details about this option.

The “Contours” menu :

The “Contours” menu allows the user to select the contour interval of the last selected field. 

The list of the contour intervals is taken from  the definition of the variable that the program finds in the 
$ARMNLIB/data/dict_rec.e file or the $HOME/.recrc file. If no variable is found, then the program does a wild guess 
about the typical magnitude of the variable and displays a default list of intervals.

Pressure field selected with the default contour interval (4 mb)

Pressure field selected with the 0.2 mb contour interval
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Pressure field selected with the “0” contour interval. No contour lines are drawn and the field is displayed in 
smooth shading. The “0” contour interval is normally present in every field.

The same pressure field on which the 24 hr accumulated precipitation (PR) is superimposed. Note 
that the contour menu now displays the values applicable to the PR variable. If you want to 
change the PN contour interval, you need to de-activate superposition, change the contour 
interval, re-activate superposition and re-select the PR field.
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The “Options” menu :

The “Options” menu offers the following items :

• “Legend / Interpolation...” invokes a panel in which the user 
• can adjust the font size of the elements that make up the legend text
• can adjust the smooting factor
• can select the interpolation level
• See Section 7 for details

• “Contours...” invokes a panel in which the user can adjust various drawing elements for 
each of the superimposed fields. See Section 8 for details.

• “Geography...” invokes a panel in which the user can set various display options for 
geographical elements (latlon lines, lakes, rivers, etc.).  See Section 9 for details.

• “Palettes...” invokes a panel in which the user can select a set of pre-loaded color palettes 
and simple enhancement curves. See Section 10 for details.

• “Min-Max / Missing values...” invokes a panel in which the user can define manually the 
min-max values of a named variable (eg. PN, GZ, TT, etc.). See Section 11 for details.

• “Vector fields...” invokes a panel in which the user can select various options of 
displaying vector fields. See Section 12 for details.

• “Point Values...” invokes a panel in which the user can select various options of displaying point values (clouds of values defined 
on latlon points. See Section 13 for details.

• “Field Editing...” invokes a panel in which the user can modify the contents of  a field. See Section 14 for details.
• “Time Animation” invokes a panel in which the user can use time animation to analyse the temporal evolution of a 2D field. See 

Section 15 for details.
• “Time Series” invokes a panel in which the user can analyse time series and Hovmoller diagrams for various points of the field. 

See Section 16 for details.
• “Vertical Cross-sections...” invokes a panel in which the user can display vertical cross sections of the field. See Section 17 for 

details.
“Vertical Animation across vertical...” invokes a panel in which the user can use vertical animation to analyze the vertical structure 
of a 3D field. See Section 18 for details
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The 2nd row of the Control Panel is composed of two buttons : “Zoom”, that allows to zoom in/out the data, and “Grid point values”, 
that displays the values of the data at grid points.

The “Zoom” button :

The “Zoom” function is activated with the 3 buttons of the mouse. The left mouse buttons is used to zoom in, the middle mouse button 
is used to pan, and the right mouse button is used to unzoom the field to its original size. There is no intermediate “unzooming”; 
unzooming always reverts to the original domain.

To zoom in : click the “Zoom” button, click in the drawing windows with left mouse button, draw rectangle until the desired area is 
covered, click again to confirm, otherwise select another area.
To pan : click the “Zoom” button, click in the drawing window with middle mouse button, drag anchor point to another part of the 
window, click with left mouse button to confirm, otherwise select another anchor point.
To unzoom : click the “Zoom” button, click with right mouse button.

Before zoom After zoom

Before pan After pan
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The “Grid Point Values” button :

This button is used to get numerical values at grid points. Once activated, a click in the drawing window with the left mouse button will 
print the numerical value of the fields displayed (up to a maximum of 4) at the nearest grid point, along with the grid coordinates 
(following RPN standard files and FORTRAN conventions). A click with the middle mouse button will redraw the window, causing 
previously displayed values to be erased, and a click with the right button will de-activate that function. Here follows two examples, 
with one field displayed (left) and 4 fields displayed (right).Note that the wind fields are displayed following the <dir,speed> 
convention, where "dir" is the true wind direction (relative to the pole) and "speed" is the modulus of the wind.

 

The 3rd row controls the overlay of fields. “Activate superposition” allows the selected field to be overlayed among those already 
displayed. “Redraw Window(s)” redraws the Windows that may have been damaged by the other windows of the graphics 
environment. “Erase all Fields” cleans the drawing area and erases all the fields from the display stack.

The “Stop” button stops the program during long operations.
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The last part of the “Control panel” contains the coordinates of the displayed area. It is <1,1> .. <ni,nj> when the field is zoomed out, 
and shows intermediate values when the field is zoomed in.

Whole field displayed Zoomed area displayed
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